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About this document
Characters and symbols

1 ABOUT THIS DOCUMENT

Use this training manual during training but also to repeat what you have already
learned.

Use the training manual to familiarise yourself with the installation and basic
functions of Geberit ProPlanner.

The topics at a glance:
• Installation and licensing
• Projects and subprojects
• Printing and data export
• Adapting Geberit ProPlanner to your own needs

1.1 Characters and symbols
The following characters and symbols are used in this training manual:

Symbol Designation Meaning
Info Reference to additional information on the subject

under Help or in another training manual
Hint Hint for an easier or better approach

Note Basic information on a specific procedure

Action Instruction for action consisting of only one step
1.
2. Instruction for action consisting of several steps

Result Result of an action

Find further information using the Help menu or by pressing F1.
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Installation and licensing
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2 INSTALLATION AND LICENSING

Install and register the software before starting up Geberit ProPlanner. You can
then use certain modules free of charge but will need to purchase a license for
others.

Please note the technical prerequisites necessary for installation and operation of
the software.

2.1 Technical Prerequisites
The following technical prerequisites apply to the Geberit ProPlanner 2025 version:

Minimum Recommended
Operating system 64 bit operating system

Windows 8.1
Windows 10
(version 1809 or later)
Windows 11

64 bit operating system
Windows 10
(version 1809 or later)
Windows 11

Processor Intel or AMD multi-core
processor

Intel or AMD multi-core
processor

Computer memory 2 GB 4 GB
Hard disc space 3 GB free 6 GB free
Graphics card 64 MB, DirectX 9 256 MB, DirectX 9
Display 1280 pixels, horizontal

resolution, 900 pixels,
vertical resolution

1400 pixels, horizontal
resolution, 1024 pixels,
vertical resolution

96 dpi (display resolution) recommended
Online services Internet access

Valid email address
System components Included in delivery and installed automatically:

• Microsoft.NET Framework 4.7
• Microsoft DirectX 9
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2.2 Installation
1. Call up the following Geberit website at: 

https://www.geberit.de/planung-installation/
planungsunterstuetzung/proplanner/.

2. Download the Geberit ProPlanner installation file and double-click on the
installation file.
✓ The installation wizard starts up.

3. Click on Install.
✓ The installation files are downloaded.
✓ Geberit ProPlanner is installed and starts automatically after the

installation.

Geberit ProPlanner automatically checks for updates every time the program starts
and installs them in the background.
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Installation and licensing
Starting the program for the first time

2.3 Starting the program for the first time
When first starting the program, you will need to specify the licence agreement and
privacy policy, as well as your country. The choice of country affects the available
modules.

The assignment to a sales company and the associated fundamental module
selection cannot be subsequently changed.

1. Accept the licence agreement and privacy policy.

2. Click on Next.

3. Select your country.
✓ As soon as you have selected a country, you will be assigned to a sales

company and a market. The user interface language will also be set
accordingly.

4. Click on OK to apply the setting.
✓ The Geberit ProPlanner registration page appears.
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2.4 Registration
You must register after starting the program for the first time. Registration is free of
charge and every corporate customer receives a corporate key. The name of the
individual is entered with private customers in place of the name of the company.

Continue reading under "Registering with a Corporate Key or License File",
page 9 if you have already received a corporate key.

2.4.1 Registering as a New User of Geberit ProPlanner

Proceed as follows if your company has not yet used Geberit ProPlanner:

1. Select the first registration option.

2. Click on Next.

3. Enter your full contact details.

Make sure that you enter your contact details correctly as they cannot
subsequently be changed.
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4. Click on Next.
✓ You data is transmitted.
✓ You will automatically receive the corporate key by e-mail.

5. Once you have received the corporate key by email, enter it and confirm with
Finish to complete registration.

2.4.2 Registering with a Corporate Key or License File

Proceed as follows if your company has already used Geberit ProPlanner:

1. Select the second registration option.

2. Click on Next.

3. Import your company's license data from the license file or manually enter the
registration details and corporate key.

4. Click on Finish to complete registration.

2.4.3 Offline Registration

You can register offline if you do not have internet access and your company has
not yet registered.

1. Start Geberit ProPlanner and register as a new user.

2. Call your sales company to obtain a corporate key and additional information.
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2.5 Licensing
After registering, you can use some modules free of charge but will have to
purchase licenses for additional modules. The licenses are issued for a limited
period of time but can be used on many computers as required.

The available modules depend on the respective sales company.

2.5.1 Buying a License

1. Start Geberit ProPlanner.

2. In the menu list, click on Help and select License management.

3. Select a module and click in the relevant line on Administrate.

4. Enter your e-mail address and send off the license order.

Call the relevant sales company if you do not have internet access.
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2.5.2 Using the License on Additional Computers

The licenses purchased by your company can be used on as many computers as
required. If your computer has an internet connection, your licenses will be
automatically downloaded onto all computers when you start Geberit ProPlanner.

If your computer does not have an internet connection, export your licence data
into a license file and then import it again on another computer.

2.5.2.1 Exporting License Data

1. Start Geberit ProPlanner.

2. In the menu list, click on Help and select License management.

3. Click on Export license data and select a directory.

4. Copy the license file onto all computers on which you wish to use Geberit
ProPlanner.

2.5.2.2 Using the License on Additional Computers

1. Start Geberit ProPlanner.

2. In the menu list, click on Help and select License management.

3. Click on Import license data and confirm the security query.

4. Switch to the directory into which you have copied the previously exported
license file and select a license file.
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2.6 Geberit ProPlanner start page
The following program window appears as soon as Geberit ProPlanner has
started:

1
2

3

4

5

6

7

1 Menu toolbar
2 General toolbar
3 Open project
4 First steps
5 Provide user feedback on Geberit ProPlanner
6 Create a new project
7 Program information

2.6.1 Opening a Project

Available projects are displayed in the Open project area as soon as the projects
have been saved.

Clicking on the respective project lets you open the project directly.

2.6.2 First Steps

The First steps area provides help and information on innovations in the current
version of Geberit ProPlanner. There is also a link via which you can call up the
training manuals and additional documents. Search wizards and training videos are
also available in some markets.

12 Training Manual Geberit ProPlanner 2025 - Installation and Basic Functions



Installation and licensing
Geberit ProPlanner start page

2.6.3 Program Information

This is where to find:
• Information on the program version
• Information on the selected market
• Information on the selected language
• Information on the data version
• Date of the price lists used
• Link to Geberit on the internet
In addition, by clicking on the market or language you can call up the Market and
language selection window and change the set market or set language.

2.6.4 Creating a New Project

By clicking on a module in the Create a new project area you are able to create a
new project.

The modules you can select depend on the sales company and respective license.
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3 PROJECTS

You always work within a project in Geberit ProPlanner. A project can consist of
several subprojects from the following modules:
• Installation systems
• Schematic planning
• Detailed planning 3D
• Roof drainage system
When you create a new project, a subproject of the module you have selected is
automatically added.

You can only select modules that you have licensed and are available in the
selected market.

3.1 Creating a new project
You will now create a new project and, initially, enter the general project data (e.g.
the person responsible for the project) and specific project data (e.g. hourly rates).

1. Activate Enter project data during creation and Enter building and
calculation settings upon creation on the home page.

2. Click on a module in the Create a new project area.
✓ The New project wizard appears.
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Projects
Creating a new project

3.1.1 Entering project data

You can also enter or change the project data at a later stage. Click on the
Change project data link in the Project window.

1. Click on Project information and enter the data for the project.

✓ This information appears in the title block of the drawing area and on the
cover sheets of lists.

2. Click on Plumber/sanitary engineer to change the company logo and enter
the address of the person responsible for the project.

✓ The logo and the sanitary engineer's details appear in the title block and on
the cover sheets of lists.

3. Use the arrow keys to select a template for the Title block.
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Projects
Creating a new project

4. Click on Next and document the Change history of the project.

✓ The Change history appears on the cover sheets of lists.

5. Click on Next to specify the Hourly rate and the Value Added Tax for
Quotations.

6. Click on Finish to exit the wizard.
✓ The Building settings window appears with the Detailed planning 3D and

Schematic planning modules.
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Projects
Creating a new project

3.1.2 Defining building and calculation settings

In the Detailed planning 3D and Schematic planning modules, an installation unit in
a building is assigned to every plan in the working area.

Define the properties of the building in the Building settings window. Determine
the settings for the calculation in the Calculation settings window. You can
separately define the settings for the entire building or single floors, building stacks
or installation units.

2

4

6

5

3

1

1 Installation unit in the attic floor
2 Installation units on the 2nd upper floor
3 Installation units on the 1st upper floor
4 Installation unit on the ground floor
5 Installation unit in the underground floor
6 Building stacks 1 and 2

You can also adapt the building and calculation settings at a later stage. Click on
the Building settings… link or Calculation settings… in the Building window.
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3.1.2.1 Entering building properties

You can define how many floors or building stacks the building in your plan is to
have in the Building settings window. You can also adapt the properties of the
single floors and label the installation units.

3.1.2.1.1 Defining the building size

1. Highlight the entire building in the Building settings window by clicking on one
of the arrows at the corners of the building.

✓ The Building area is activated.

2. Change the number of floors in the Building area and click on Apply.
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Projects
Creating a new project

3.1.2.1.2 Defining floor properties

1. Highlight one or more floors by clicking on one of the arrows at the sides of the
building.

✓ The Floor area is activated.

If you wish to change several floors at the same time, highlight the floors by
holding down CTRL.

2. Adapt the settings for Room height (above finished floor), Floor
construction height and Ceiling thickness in the Floor area.

3.1.2.1.3 Labelling installation units

1. Highlight an installation unit in the Building window by clicking on it in the
building.

✓ The Installation unit area is activated.

If you wish to change several installation units at the same time, highlight the
installation units by holding down CTRL.
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2. Enter the label of the installation unit in the Designation field.

3. Activate the Hide inscription with building stack and floor when the
designation is available checkbox.

4. Click on Close to apply the building settings.
✓ The Calculation settings window appears.

3.1.2.2 Defining calculation settings

You can define uniform calculation settings for the entire building. Properties that
are defined for the entire building are carried over and applied to all floors and
installation units. Any deviating properties can be defined either for a floor or an
installation unit.

3.1.2.2.1 Defining settings for the entire building

1. Highlight the entire building in the Building preview area by clicking on one of
the arrows at the corners of the building.

2. Select the required module or product range in the left area of the Calculation
settings area and define the respective properties for the calculation of your
plan.

If you need to, you can enlarge the Building preview by clicking on the symbol
Enlarge building.
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3.1.2.2.2 Defining settings for a floor

1. Highlight a single floor in the Building preview area by clicking on one of the
arrows at the sides of the building.

If you wish to change several floors at the same time, highlight the floors by
holding down CTRL.

2. Select the required module or product range in the left area of the Calculation
settings area and define the respective properties for the calculation of your
plan.

3.1.2.2.3 Defining settings for an installation unit

1. Highlight an installation unit in the Building preview area by clicking on it in
the building.

If you wish to change several installation units at the same time, highlight the
installation units by holding down CTRL.

2. Select the required module or product range in the left area of the Calculation
settings area and define the respective properties for the calculation of your
plan.

3. Click on Close to apply the calculation settings.
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3.1.2.2.4 Adapting settings for trades and product ranges

1. Enter the required settings for the individual trades or product ranges in the
other tabs. Note when doing so that you will have to adapt the settings for the
entire building or highlighted floors or installation units, depending on the
selection in the building.

2. Click on Close to apply the settings.

• You will learn how to adapt the building and calculation settings in detail in the
respective Detailed planning 3D and Schematic planning training manuals.

• More information on the building and planning principles within a building can
be found in the Help at Schematic planning > Building or Detailed planning
3D > Building.

3.1.3 Saving a Project

1. Click in the toolbar on Save.

2. Enter a file name in the Save project as window.

3. Click on Save.

As soon as a project has been saved, the project appears in the Open project
area on the Start page and is automatically linked.

Remember to save your projects regularly.

3.2 Creating subprojects
You can create and edit several subprojects within a project. There are various
functions available to you to manage your subprojects so that you retain an
overview of them.

3.2.1 Adding subprojects

1. Click on Add subproject in the toolbar.

2. Select a module.
✓ The subproject appears in the Project window.
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3.2.2 Renaming Subprojects

Geberit ProPlanner automatically names subprojects according to the respective
module. If you wish to create several subprojects of the same module, you can
rename the subprojects to differentiate more easily between them.

1. Right-click on the subproject in the Project window and select Rename in the
pop-up menu.

2. Enter a designation and confirm with Enter.

3.2.3 Copying Subprojects

Copy this installation as follows if you wish to plan an installation multiple times:

1. Double-click on a subproject in the Quantity field in the Project window.

2. Enter the required number per subproject and confirm with Enter.
✓ The number previously entered appears in the Quantity column.
✓ The quantities will be adjusted in the material list to match this figure.

Additional information is available in the Help under Projects and subprojects >
Subprojects.
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4 PRINTING AND EXPORTING

Geberit ProPlanner lets you print or expert your lists and drawings.

You can export graphics in the following formats:
• 2D CAD file (DXF/DWG)
• 3D CAD file (DXF/DWG)
• Other image formats (TIF, JPEG, BMP etc.)
Export lists as Excel or CSV files. You can also export your plan for use in industry
software (GAEB, UGL, IGH451, CalWin).

4.1 Printing and exporting graphics

4.1.1 Selecting Graphics

Proceed as follows to print or export graphics in the Detailed planning 3D,
Schematic planning and Roof drainage system modules:

1. Click in the toolbar on Display/print graphics.
✓ The Print/export window appears.

If you print or export graphics in the Detailed planning 3D module, the installation
unit selected in the Building window will be printed or exported. The item in the
building appears in the title block. Other installation units and subprojects cannot
be selected here.

2. Select which view you wish to print or export in the Graphics area.
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Printing and exporting
Printing and exporting graphics

4.1.2 Printing Graphics

1. Select a printer in the Output area.

2. Select the paper format to be used by the printer. The paper format needs to
be supported by the printer.

For an optimum printing result, select the same print format that you have
defined for the planning.

3. Select whether you wish to print with or without fold markings if you have
selected an A3 or larger paper format.

4. If you need to, click on Printer settings to adapt the advanced settings for
your printer, e.g. select paper tray, activate printing on both sides.

5. Select the Print at drawing scale option in the Format adjustment area.

• If the paper format in the printer differs from the paper format of the planning,
you can automatically reduce or enlarge the graphic to a sheet or manually by a
user-defined percentage when printing. The scale of the drawing is then lost.

• Select a User-defined scaling of more than 100% to distribute a graphic in a
large format on several pages to be glued together.

6. Click on Print.
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4.1.3 Exporting Graphics

1. Select the required graphic format in the Output area.

If you open the print dialogue using the File > Data exchange menu item, you
can immediately call up the required graphic format.

2. If you have selected Image file (various formats), specify the Character
width of the graphic.

3. Click on Export.

✓ The Save as window appears.

4. Select the storage location you require and the File type and enter a file name.

5. Click on Save.
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4.2 Printing and exporting lists

4.2.1 Selecting Lists

Proceed as follows to print or export lists:

1. Click on Display/print lists in the toolbar.
✓ The Print/export window appears.

2. Select from which subprojects or installation units you wish to print or export
lists in the Source data area.

3. Select which modules the list is to contain.
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4. Open the range of list types in the Lists area and select the lists you require.

• Clicking on  lets you adapt the respective list to your requirements.
• More information on adapting lists and saving the settings can be found in the

Help at Print and export > Print lists.
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Printing and exporting lists

4.2.2 Printing Lists

1. Select a printer in the Output area.

2. Select the paper format to be used by the printer. The paper format needs to
be supported by the printer.

3. Select whether you wish to print with or without fold markings if you have
selected an A3 or larger paper format.

4. If you need to, click on Printer settings to adapt the advanced settings for
your printer, e.g. select paper tray, activate printing on both sides.

5. Select which pages you wish to print.

6. If you need to, click on Printer settings to enter the advanced settings for your
printer, e.g. select paper tray, activate printing on both sides.

7. Select the number of Copies in the Print area.

8. Click on Print to start the printing process.
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4.2.3 Exporting Lists

1. Select Excel export or CSV export in the Output area.

2. Click on Export.

✓ The Save as window appears.

3. Select the storage location you require and enter a file name.

4. Click on Save.

4.3 Export for industry software
Geberit ProPlanner provides various export formats to facilitate a uniform standard
for the exchange of data for specifications or requests for tenders:
• GAEB
• UGL
• IGH451
• CalWin

The export formats offered depend on the market set in the program settings.

1. Click on Data exchange in the File menu and then on an export format.

2. Select the subprojects you wish to export.

3. Select a file format and other settings for the GAEB export.
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4. Enter a customer number, a supplier number and one of the following kinds of
enquiries for the UGL export:
• TB: Call-off order by contractor to wholesaler
• AN: Enquiry from contractor to wholesaler
• BE: Order by contractor to wholesaler
• A0: Call-off by contractor to wholesaler for delivery from a call-off order
• A1: Call-off by contractor to wholesaler for delivery from a quotation
• A2: Creation of a call-off order from a quotation
• PA: Price quotation by wholesaler to contractor
• AB: Order confirmation by wholesaler to contractor

5. For the IGH451 export, enter Export type and the data for Customer and
Vendor.

6. Click on Export.

7. Select the storage location you require and enter a file name.
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5 ADAPTING PROPLANNER TO YOUR OWN
NEEDS

5.1 Adapting the window layout
You can also move single windows or change the window layout to enlarge the
space in the drawing area when planning.

5.1.1 Selecting the Window Arrangement

The following window layouts are available in all modules in Geberit ProPlanner:
• Default window arrangement 1 with many opened setting windows
• Default window arrangement 2 with preferably large drawing area
• User-defined window arrangement with your save window layout

Proceed as follows to select one of the window layouts:

1. In the menu list, click on View and select Window arrangement.

2. Select Default window arrangement 1, Default window arrangement 2 or
User-defined window arrangement.

The User-defined window arrangement is available as soon as you have saved
a proprietary window arrangement for the respective module.
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5.1.2 Arranging Windows

The user interface windows can be moved and arranged as required for every
module in Geberit ProPlanner.

5.1.2.1 Showing and Hiding Windows

1. Click on the pin in the title bar of a window.

✓ The window is hidden but remains visible at the edge as a tab.

2. Click on the corresponding tab if you wish to show the window temporarily.

3. If you wish to show the window permanently, click on the pin in the title bar of
the window.

5.1.2.2 Re-docking Windows

You can move a window so that is it then docked at a new position. To do so, first
cancel the fixed arrangement.

1. Click on Window arrangement in the View menu and deselect Lock window
arrangement.

2. Move the windows by clicking in the title bar and, holding down the left mouse
key, slide them using one of the blue arrows. A total of 8 blue arrows are
visible.
✓ The new position of the window appears as a blue rectangle.

✓ Your window will be docked in its new position when you release the
mouse key.

3. If you wish to protect the new window layout from unintentional changes, click
on Window arrangement in the View menu and activate Lock window
arrangement.
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5.1.3 Saving a Window Layout

You can save a separate window arrangement for each module.

1. Click on Window arrangement in the View menu and select Save window
arrangement.

✓ An information window appears.

2. Confirm with OK.

5.2 Changing the view in the objects window
In the Detailed planning 3D and Schematic planning modules you can select
between the Large symbols and Tree views in the Objects or Pipes/objects
window. The Dropdown view is also available in the Detailed planning 3D module.
Right-clicking in the Objects or Pipes/objects window lets you switch views in the
pop-up menu.

The objects are displayed in a tree structure in the Large symbols and Tree
views. Expand the tree structure using the triangle in front of the entry and select a
specific object. Otherwise Geberit ProPlanner will insert a market-dependent
default object.

Large symbols view (on left) and Tree view (on right)
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You can select an Object type in the Dropdown view and define the other
properties of the installation element in the selection fields.

Dropdown view in the Detailed planning 3D module
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5.3 Adapting the visualisation of the drawing area
You can adapt the visualisation of the drawing area and your plan in the Layer
window in the Detailed planning 3D, Schematic planning, Roof drainage system
and Waste water prefabrication modules. You can partly or fully show and hide the
pipes, objects, legends, labels, the drawing area, images and CAD plans. You can
lock elements of your plan to prevent unintentional moves.

5.3.1 Showing and hiding elements

1. Show the Layer window.

2. Click on  beside the element to show the element.

3. Click on  beside the element to hide the element.

5.3.2 Locking elements

Locked elements cannot be selected or moved. The properties of locked elements
cannot be called up and cannot be changed.

1. Click on  beside the element to lock the element.

2. Click on  beside the element to unlock the element.
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5.3.3 Managing layer settings

You can save and upload your setting in the Layer window so that you can quickly
switch between different settings.

5.3.3.1 Saving layer settings

1. Click in the Save layer settings in the Layer window.

✓ The Layer window appears.

2. Enter a Designation.

Save this setting as the default setting for all additional projects of the module by
activating Use as default.

3. Click on Save.

5.3.3.2 Selecting layer settings
▶ Select the setting you require in the Layer settings selection field.

Depending on the market, in the module Schematic planning, you can easily
switch between the various default settings and customised settings using the
quick layer selection.
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5.3.3.3 Deleting layer Settings

▶ Expand the Layer settings selection field and click on  next to the layer
setting you wish to delete.
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5.4 Using your own company logo
You can use your own logo instead of the Geberit logo to customise your lists and
quotations. The logo and the sanitary engineer's details will appear later in the title
block and on the cover sheets of lists.

1. Show the Project window.

2. Click in the Project window on Change project data.
✓ The Project data window appears.

3. Click on Plumber/sanitary engineer.

4. Click on Change company logo and select an image file.

5. Click on Open to integrate the image file.

6. Click on Finish to apply the settings.
✓ Your logo now appears in the title block and on the covers sheets of lists.
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5.5 Adapting hourly rates and VAT
1. Show the Project window.

2. Click on Change project data in the Project window.
✓ The Project data window appears.

3. Click on Quotations.

4. Adapt the default Hourly rate and the default Value Added Tax.

5. Click on Finish to apply the settings.
✓ The quotations are calculated with the modified hourly and VAT rates.

5.6 Saving settings as default settings
You can save the settings entered as default settings for new subprojects in many
windows or tabs. As soon as a new subproject has been created, it is automatically
given the saved settings. For instance, you can save general settings, like your
own logo or your individual hourly rate as a user default.

You can also save specific settings in the respective modules as a user default,
such as settings for potable water or waste water in the Schematic planning
module.

When saving, you can select whether you wish to save the settings of the current
tab or the settings of several tabs as a user default.
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5.6.1 Saving the settings of the current tab as a user default

▶ Click on Default settings and select Save as user default.

✓ The settings of the current tab have been saved as a user default.

5.6.2 Saving the settings of multiple tabs as user defaults

1. Click on Default settings and select Default settings.

✓ The Default settings window appears.

2. Select All settings.

3. Click on OK to save the settings of the selected tab as the user default.
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5.7 Resetting settings to default settings
If required, you can reset the modified settings of one of more tabs to the user
default or the ProPlanner default.

5.7.1 Resetting the settings of the current tab to default settings

1. To reset the settings of the current tab to the ProPlanner default, click on
Default settings and select Reset to ProPlanner default.

2. To reset the settings of the current tab to the user default, click on Default
settings and select Reset to user default.

5.7.2 Resetting the settings of multiple tabs as default settings

1. Click on Default settings and select Default settings.

✓ The Default settings window appears.

2. If you wish to reset the settings to the user default, select the Reset settings
to user default option.

3. If you wish to reset the settings to the ProPlanner default, select the Reset
settings to ProPlanner default option.

4. Activate the respective checkbox for every tab, the settings of which you wish
to reset.

5. Click on OK to reset the settings of the selected tabs.
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5.8 Surcharges and discounts on material and time
Specify surcharges or discounts for various items in the lists, which are then taken
into account when calculating the lists. On request, you can specify that the
surcharges imposed or the discounts granted are displayed in the lists.

1. Click on Display/print lists in the toolbar.
✓ The Print/export window appears.

2. Click on Settings for all lists.

✓ The List settings window appears.

3. Click on Additional charges.
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4. Enter positive values for surcharges and negative values for discounts.

5. Activate the respective checkbox Display note if you wish a note to be
displayed in the lists about the surcharges imposed or discounts granted.

6. Click on OK to apply the settings.
✓ The lists are updated and the activated notes are issued.

5.9 Favourites
Create favourites to reuse individual constructional situations on future plans. You
have the option of saving single objects or complete assemblies as favourites.
Assemblies can be several connected objects within a pipe system (e.g. a
basement installation).

Quickly call up favourites in the Favourites window and place them like objects
into the drawing area.

Rename your favourites and arrange them in folders to make the favourites list
clearer.

Single markets provide predefined favourites. Predefined favourites are shown in
italics and cannot be reorganised or deleted.
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5.9.1 Creating Favourites

1. Highlight one or more objects in the drawing area.

2. Right-click on the highlighted objects and select Add to favourites in the pop-
up menu.

3. Click on Window in the View menu and select Favourites.
✓ If you have highlighted an object, the object will appear with a symbol and

object designation. If you have highlighted several objects, the assembly
will appear with a star symbol and the designation New favourite.

5.9.2 Using Favourites

1. Open the Favourites window.

2. Highlight a favourite.
✓ The favourite is suspended from your cursor and appears in the drawing

area.

3. Click at the required position in the drawing area to place the favourites.

5.9.3 Organising Favourites

5.9.3.1 Renaming Favourites

You can rename objects, installation walls and the Favourites folder.

1. Highlight the Favourites in the working area.

2. Right-click on the favourite and select Rename in the pop-up menu.

3. Enter a name for the Favourite.

4. Press Enter to confirm the name.
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5.9.3.2 Deleting Favourites

1. Highlight the Favourites in the working area.

2. Right-click on the favourite and select Remove in the pop-up menu.

5.9.3.3 Organising Favourites into Folders

Organise your favourites in folders to make the favourites list clearer.

1. Right-click in the Favourites window and select New favourites folder in the
pop-up menu.
✓ The favourites folder appears in the Favourites window.

2. Highlight the favourites folder.

3. Right-click on an object or installation wall in the drawing area and select Add
to favourites in the pop-up menu.
✓ The object or the installation wall appears in the favourites folder.

4. Expand or collapse the Favourites folder by clicking on the triangle ( ).

Press and hold down the left mouse key to move existing favourites into a
Favourites folder.

5.9.3.4 Export favourites

You can export favourites to swap favourites between different Geberit ProPlanner
installations. You can then file the favourites at a central place and access them
from different locations.

Favourites can only be swapped between subprojects of the same type within the
same market, from one Geberit ProPlanner installation to another Geberit
ProPlanner installation.

1. Highlight an object or a Favourites folder in the Favourites window.

2. Right-click on the favourite and select Export in the pop-up menu.

3. Enter a file name and select a storage location in the Save As window.

4. Click on Save and confirm the information window with OK.
✓ A Favourites file with the file extension .gpf is saved.
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5.9.3.5 Import favourites

Import exported favourites into every subproject of the same module and the same
market.

1. Right-click in the favourites window and select Import in the pop-up window.

2. Open the folder in which the favourites file is saved.

3. Highlight the file and click on Open to import the favourites into your
subproject.

4. Confirm the information window with OK.
✓ Favourites appear in a new favourites folder in the favourites window.
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